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This is the age of computers. Computer is undergoing rapid 
change, and new and improved technological advances appear 
almost daily. Computers have invaded all walks of life to such an 
extent that computer literacy has become the order of the day.  
Computer  science is now an essential addition to the school curriculum at all 
levels. 

Computer Zone is a series of ten books on Computer Science for school level, 
designed for the new generation of students who need to acquire knowledge 
on the theory, application and programming aspects of computing. Logical 
and scientific in its approach, the series covers the history of computer, its 
accessories, applications and programming in a step-by-step and graded 
manner. It has been prepared to focus on creativity and encourage young 
children to explore and experiment with learning opportunities.

This book is the third in the series and is recommended for use in class 3. 
The chapters are supplemented with lucid illustrations, practise exercise, brief 
summaries and a variety of theory and lab exercises, that ensure mastery 
over the concepts learnt.

A lot of research and meticulous attention to detail have gone into the making 
of this book. However, there is always scope for improvement. Constructive 
criticism and suggestions which could be incorporated in the future editions of 
this book, are welcome. 

I earnestly hope that the students would find the journey through this series 
an enjoyable experience and gain a sound working knowledge on the 
basic aspects of computing that lay the foundation for good and systematic 
programming. 

-Author

PrefacePreface
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•	 	Explain the importance of computer.
•	 	Define computer and explain the basic functions of a computer.
•	 	Define data and information.
•	 	Explain the features of computer.
•	 	List the applications of computer.

Chapter1
Computers

Everywhere

Learning Objectives

An  Overview

Computers play a very important 
role in our life. It is very hard to 
imagine modern life without 
computer. The computers are 
used in different places by 
different people. Everywhere we 
are surrounded by these “mighty 
machines” at home, at work, in 
our schools,  restaurants and even 
our corner stores. So, computers 
are a boon to the mankind.
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Computer and its Basic Functions

The word computer is taken from a Latin word “Computare” 
which means “calculate or compute”. It works on electricity.  
Computer can understand electric signals only.  It is a machine 
that accepts unorganised data,  performs calculation and produces 
the meaningful information.  Thus, the computers are also called 
data processing machine.

A computer can be defined as “an electronic machine that converts data into 
information using a program.”

Definition

expanding 
your horizons

A computer is machine which performs the following functions:

a.	 INPUT 	 -	 Accepts data given by you		

b.	 Processing 	 -	 Processses the data according to the given 
instructions  

c.	 Output 	 -	 Produces result		

d.	 Storage 	 -	 Stores the results	

Monitor

Keyboard

Mouse

CPU tower
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Data and Information

Data is the collection of raw-facts.  It can be any name, sentence 
or number. It is simply a fact given to the computer which are not 
arranged in the proper order.  So, it must be arranged to provide 
meaningful result to us.  Computer processes the data to convert 
it into information. The result of your data that you get after 
processing is called information. It is meaningful and organized.

Processing
Data Information

Features of Computer

Computers are not very intelligent devices but they are useful 
to us.  They are used in different places by different people for 
different purpose.  It is a special device.  Let us learn what makes 
this device so special. 

Speed
Computer works at a very high speed.  They can do large amount 
of calculations at a very high speed.
 
Accuracy
Computer does any type of work without mistakes.  It is 100% 
accurate.  If the data and instructions entered are correct, then 
the output also will be correct.

Data is the collection of raw-facts whereas information is data arranged.

Definition
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Diligence
Computer can work continuously for a long time without taking 
rest.  Computer is a machine and does not complain.  

Automatic
Computer is automatic.  It carries out the processing without any 
help, once the instructions are prepared and given to it.  

Storage capacity
Computers have very high memory. They can store large amount 
of data and information. It is easy get the information from them 
in seconds.

Communication
Today, the computer has  become the most powerful 
communicating devices. You can communicate over any corner 
of world through Internet sitting at one place on computer.
Computer is a programmable device having special features.  
So, computer is used in every aspect of our lives. Life without 
computer is unimaginable.

expanding 
your horizons

One of the reasons the Internet is so important in 
education is because of the wealth of information that 
the Internet contains. The Internet has become very 
useful in the field of education and every news information 
is available online so you can update yourself any time according to your own 
needs and time table. The biggest source for online information for education is 
the encyclopedia and it is available online and any one can use it to get desired 
information.
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Computers Everywhere

Computers have changed everyone’s 
life. They are becoming more and more 
widespread in all areas of life - in industry, 
business, education and training, arts, 
entertainment and leisure. Some of the 
uses of computer are as follows.
a.	 You can use your computer to create letters, resumes, reports, 

etc.
b.	 You can use your computer to chat with other people by 

typing messages to them.
c.	 You can use your computer to play music and watch films.
d.	 You can use your computer to play different types of games.
e.	 You can use your computer for doing calculations.

Facts Corner

We operate washing machines, microwave oven and many 
other products using computer. Moreover we can store all the 
information about our important work, appointments schedules 
and list of contacts. 



6 Computer Zone - Book 3

Computer	 :  	 A machine that accepts 
unorganised data,  performs 
calculation and produces the 
meaningful information. 

Input	 :	 The data and instructions that a 
computer receives.

Data	 :	 The collection of raw-facts.
Internet	 :	 A massive public spiderweb of 

computer connections.

Tricky Terms 

Let 
Us Revise

•	 The word computer is taken from a Latin word “Computare” 
which means “calculate or compute”.

•	 Computer is a machine that accepts unorganised data,  
performs calculation and produces the meaningful 
information. 

•	 Data is the collection of raw-facts. 
•	 The result of your data that you get after processing is 

called information.
•	 Computer works at a very high speed. 
•	 Computer does any type of work without mistakes.
•	 Computer can work continuously for a long time without 

taking rest.
•	 Computers have very high memory. 
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Chapter Review
1.	 Fill in the blanks. Choose the answer from the given words.

Clue  Box

a.	 The word computer is taken from a Latin word 
__________________ which means “calculate or compute”.

b.	 ___________________is a machine that accepts unorganised 
data,  performs calculation and produces the meaningful 
information.

c.	 The result of your data that you get after processing is 
called___________________. 

d	 Computer works at a very high__________________.
e.	 Computer is____________________. 

2.	 Match each term with the statement that best describes it.
Input	   	 A machine that accepts unorganised data,  

performs calculation and produces the 
meaningful information. 

Computer		  The data and instructions that a computer 
receives.

Internet		  The collection of raw-facts.
Output		  A massive public spiderweb of computer 

connections.
Data		  The result of the work done by the processor.

Computer, Computare, Speed, Automatic, Information
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Extrapolative Exercise

One of your friend thinks it is a waste of time 
learning about computers. Write five reasons 
why you think he or she should learn computers.
a.	 ____________________________________.

b.	 ____________________________________.

c.	 ____________________________________.

d.	 ____________________________________.

e.	 ____________________________________.

3.	 Say whether these sentences are True or False.
a.	 Computers play a very important role in our life. 
b.	 Computer can understand electric signals only. 
c.	 Computer processes the information to convert it into data.
d.	 Computer does any type of work without mistakes.
e.	 Computers have very small memory. 

4.	 Answer the following questions.
a.	 What does the word “Computare” mean?
b.	 What is a computer?
c.	 What is a data?
d.	 Explain the special features of a computer.
e.	 Write any three activities that you can do on a computer.
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•	 	Define input device and explain the uses of different input devices.
•	 	Explain the importance of CPU.
•	 	Define output device and explain the uses of different output devices.
•	 	Define secondary storage device and explain the uses of different 
secondary storage devices.

Chapter2
Computer

Parts

Learning Objectives

An  Overview

A computer is a machine. It has 
different parts. All these parts 
of computer works together to 
perform a specific task. It has 
different parts such as input device 
to enter data and instructions into 
the computer, processing unit to 
perform calculations and output 
device display the work done by 
the computer. All of them together 
make a computer system.



10 Computer Zone - Book 3

Input Devices

Input device is one of the most important parts of the computer. 
Input device is a device used to enter data and instructions into 
the computer. There are many different input devices, the most 
common being a keyboard and a mouse. Without an input device, 
we cannot communicate with the computer.

Keyboard
Keyboard is one of the most important  input devices of a 
computer. It is used for entering data and instructions into the 
computer. It has different keys to perform various operations. 
The keys have letters, numbers and other symbols written on 
them. Instructions are given to the computer by pressing these 
keys.	
Mouse
Mouse is also an input device. It is a small plastic box with buttons 
on top. There is a small wheel called scroll button in the latest 
mouse. The bottom of the mouse is flat and contains a mechanism 
that detects movement of the mouse. It is placed on a mouse pad, 
which provides a flat surface for the mouse to roll on.  It is used 
to draw pictures on the screen. 
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Joystick
A joystick is an input device that is used 
to move the cursor or other objects on 
the screen of the monitor. It has a lever 
which can move in any direction. It also 
has two or more buttons. It is mainly 
used for playing computer games.	
 
Trackball
Trackball is a pointing device that 
contains a movable ball on the top. 
The user rolls the ball around with the 
finger to operate it. It moves the cursor 
in the direction in which the ball is 
moved. Trackball is mostly used in 
notebook computers.

Microphone
Microphone is an input device. It is 
used to input sound by recording your 
voice and other sound in a computer. 
It is sometimes referred to as mike or 
mic.

Scanner 
Scanner is a device that optically scans 
images, printed text, handwriting, or 
an object, and converts it to a digital 
image. Common examples found in 
offices are variations of the desktop (or 
flatbed) scanner where the document is 
placed on a glass window for scanning.
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Central Processing Unit

CPU is the most important active part of the computer system.  
It is the brain of the computer. It does all the calculations and 
processing. It also controls the operations of other parts of the 
computer. CPU is fixed inside the system unit. 

Output Devices

Output device is any device used to send data from a computer 
to another device or user. Most computer data output that is 
meant for humans is in the form of audio or video. Thus, most 
output devices used by humans are in these categories. Examples 
include monitors, projectors, speakers, headphones and printers.

expanding 
your horizons

A system unit is a box like case which stands near the 
monitor or kept under the monitor. System unit is also 
called a computer case. The system unit contains the 
essential parts of a computer such as motherboard, CPU, 
Hard disk, DVD rom, etc. It protects the internal components of a computer 
from damages. 
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Monitor
A monitor is an output device which 
looks like a television. It displays 
text, pictures and videos. It has a 
power switch located usually at the 
front. It has some control buttons that 
allows you to adjust the brightness 
and contrast of colours on the screen. 
The output shown on the monitor is 
called soft copy.	

Printer
Printer is another important output 
device attached to a computer 
system.  It prints text or illustrations 
on the paper. It is also called hard 
copy output. Dot matrix, inkjet, 
laser are the printer types commonly 
used. All these printers are available 
in colour and monochrome versions.

Speakers and Headsets
Speakers and headsets are used to 
listen to the sound being played by 
the computer system. They can be 
of different shapes and sizes. Some 
speakers are built into the computer 
and some are separate. With a good 
speaker or headsets system the 
computer can output high quality 
sound.
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Secondary Storage Devices

Secondary storage devices are the devices that are used to store 
the data and information into the computer. Hard disk, pen 
drives, DVD, Blue-ray disk and CD-ROM are the examples of 
secondary storage media and the device that uses or holds the 
media is known as a secondary storage device.

Hard disk
Hard disk is the storage device that is 
fixed inside the system unit. It is the 
main storage device of the computer. 
It can store large amount of data and 
information into it. It is also called a 
hard drive.

Pen drive
Pen drive is a small, lightweight, 
removable disk. It is very small in 
size and can be carried in a pocket or 
hand like a pen. It is used for storing 
and transferring audio, video, and 
data files from a computer.  It is also 
called thumb drives. 

Facts Corner

An HDD records data by magnetizing a thin film of ferromagnetic 
material on a disk.



15Computer Zone - Book 3

Optical Disk
Optical disk is a disk coated with reflecting 
medium. It is portable and can hold a large 
amount of data. Data is read and recorded 
through a laser beam. The optical disks 
have the capacity to store a large amount 
of data in the form of text, graphics, audio 
and video. CD-ROM (Compact Disk Read 
Only Memory, DVD (Digital Versatile 
Disk) and Blue-Ray disk are the common 
types of optical disks. 

Floppy Disk
Floppy disk is a popular secondary storage 
medium. It is a plastic disk coated with 
magnetic material. It is sealed with a 
protective jacket. A floppy disk is inserted 
into a floppy drive to read data from it or 
write information on it. It is also used to 
transfer small files from one computer to 
another. The most common size is 3.5 inches 
which holds upto 1.44 MB (megabyte) of 
data.

expanding 
your horizons

The earliest floppy disks, developed in the late 1960s, 
were 8 inches (200 mm) in diameter; they became 
commercially available in 1971. These disks and 
associated drives were produced and improved upon by IBM 
and other companies such as Memorex, Shugart Associates, and Burroughs 
Corporation.
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Input device	 :  	A device used to enter data and 
instructions into the computer.

Scanner 	 :	 A device that optically scans 
images and converts it to a 
digital image. 

System unit 	 :	 A box like case which stands 
near the monitor or kept under 
the monitor. 

Output device	:	 Any device used to send data 
from a computer to another 
device or user. 

Tricky Terms 

Let 
Us Revise

•	 Keyboard is used for entering data and instructions into the 
computer.

•	 A joystick is an input device that is used to move the cursor 
or other objects on the screen of the monitor. 

•	 CPU does all the calculations and processings.
•	 Output device is any device used to send data from a 

computer to another device or user.
•	 A monitor is an output device that displays text, pictures 

and videos.
•	 Secondary storage devices are the devices that are used to 

store the data and information into the computer. 
•	 Optical disk is a disk coated with reflecting medium. 
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Chapter Review
1.	 Fill in the blanks. Choose the answer from the given words.

Clue  Box

soft copy, CPU, output device, pen drive, joystick

a.	 A___________________is an input device that is used to move 
the cursor or other objects on the screen of the monitor.  

b.	 __________________is the most important active part of the 
computer system. 

c.	 __________________is any device used to send data from a 
computer to another device or user. 

d.	 The output shown on the monitor is called________________.
e.	 __________________is a small, lightweight, removable disk 

used for storing and transferring audio, video, and data files 
from a computer. 	

2.	 Give the names of the computer parts.

a.	 A pointing device that contains a movable ball on the top. 
b.	 A device that optically scans images, printed text, handwriting, 

or an object, and converts it to a digital image.
c.	 The most important active part of the computer system. 
d.	 A device that prints text or illustrations on the paper.
e.	 A small, lightweight, removable disk that can be carried in a 

pocket or hand like a pen.
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3.	 Say whether these sentences are True or False.
a.	 Input device is a device used to enter data and instructions 

into the computer. 
b.	 Mouse is a pointing device that contains a movable ball on the 

top.  
c.	 CPU is fixed inside the system unit. 
d.	 Secondary device is any device used to send data from a 

computer to another device or user. 
e.	 Speakers and headsets are used to listen to the sound being 

played by the computer system.

4.	 Answer the following questions.
a.	 What is an input device? Name two common input devices of 

a computer.
b.	 What is a mouse? What is the function of a mouse?
c.	 What is a scanner?
d.	 What is CPU? What does it do?
e.	 What is an output device? Name two common output devices 

of a computer.
f.	 What is an optical disk?

Extrapolative Exercise

Write the name of three computer parts in each 
category.

INPUT DEVICES OUTPUT DEVICES STORAGE DEVICES
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•	 Explain the different types of keys found in a keyboard.
•	 	Explain the methods of typing text, capital letters and punctuation 
marks.

•	 	Explain the basic mouse operations.
•	 	List the uses of the mouse.

Chapter3
Keyboard
and Mouse

Learning Objectives

An  Overview

The device that is used to give the 
input to a computer is called an 
input device. The most common 
and popular input devices are 
keyboard and mouse. A number 
of other input devices have 
been developed which do not 
require typing to input data and 
instructions. These are joystick 
and digital camera.
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A Tour of Keyboard

Keyboard is used to enter data and instructions into a computer. 
It has buttons called keys which once pressed provide input 
instructions to the computer. We can input alphabets, numbers 
and other characters. There are various types of keyboards such 
as wired, wireless, normal and multimedia keyboards. 
A keyboard is a device which consists of a number of keys. There 
are different sets of keys on the keyboard. Some of the important 
keys are discussed below:

Alphabet keys
The keys that have alphabets from A to Z written on them 
are called alphabet keys. There are 26 alphabet keys on every 
keyboard. These keys are located at the centre of the keyboard. 
They are arranged in three rows. These keys are used to type 
capital letters from A to Z or small letters from a to z.

Alphabet keys
Function keys Number keys

Spacebar keys
Enter key
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Using the Keyboard

To Type Text
You use the alphanumeric keys to type text. Text can include 
words and numbers. The numeric keypad may also be used 
to type numbers. This is possible only if the NumLock key is 
pressed. When the Num Lock key is pressed, the indicator below 
it may be lit.

Num
Lock

Caps
Lock

Scroll
Lock

To Type Capital letters, Punctuation Marks and Symbols
To type text in capital letters, you may use the Caps Lock key or 
Shift key.
To type capital letters with Caps Lock key: The keyboard can be 
‘locked’ into capitals by pressing the Caps Lock key. The key may 
be lit to indicate it is on. To return to lowercase letters, press the 
Caps Lock key again.
To type capital letters with a Shift key: Hold down the Shift key 
while pressing the letter keys. To return to lowercase letters, 
release the Shift key.

+ =

To Type Punctuation Marks and Symbols
The upper half of some keys have:
Punctuation marks like exclamation mark (!) and question mark 
(?).
Symbols like at (@) and ampersand (&), and brackets ( ).
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Numeric keys
The keys that have numbers from 0 to 9 are called numeric keys. 
These keys are used for typing numbers. There are two sets of 
number keys present on a keyboard. One is above the alphabet 
keys and other at the right corner of a keyboard.

1        2        3	        4	      5	    5        6         7        8        9        0 

Function keys
A set of twelve function keys are found in a single row at the top. 
They are labelled from F1 to F12. These keys have special jobs to 
do.

Arrow keys
The arrow keys help us to move the cursor in all the four directions 
on the screen. Cursor is the blinking line on the screen. Arrow 
keys are also called cursor control keys.

expanding 
your horizons

The numeric keypad is found at the right of the keyboard. 
It has the digits 0 to 9. There are also a decimal point, 
plus and minus signs, together with four special keys 
labelled Num Lock, Scroll Lock, Ins (Insert) and Del (Delete) keys.



23Computer Zone - Book 3

A Tour of Mouse

Mouse is another commonly used input 
device. It is moved by hand around a flat 
surface. When the mouse is moved the cursor 
on the monitor screen moves accordingly. A 
mouse has two or three buttons which are 
used for various actions such as selecting 
an object, moving an object, etc. There are 
various types of mouse such as wired, 
wireless, mechanical and optical ones.

Special keys
The function of some special keys are given below:
Special key	 Use
Backspace	 The backspace key erases the letter or 

number to the left of the cursor.
Delete key	 The delete key is used to erase the letter or 

number on the cursor position.
Spacebar	 The spacebar is the longest key on the 

keyboard. It is used to give spaces between 
the letters or numbers typed.

Enter key	 The enter key tells the computer that the 
instructions being typed are complete. It is 
also used to move the cursor to the next line, 
when you want to start a new paragraph.

Caps lock key	 The caps lock key is used to change from 
small letters to capital letters. Caps lock can 
be turned ON by pressing the caps lock key 
once. It is turned OFF by pressing the caps 
lock key again.
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Basic Mouse Operations

The computer’s mouse controls a 
graphical mouse pointer or mouse 
cursor on the screen. When you move 
the mouse around by rolling it on 
your desk, the pointer on the screen 
moves in a similar manner. 
Some of the basic mouse operations are: 
Pointing
Move the mouse so the mouse pointer is kept on the item you 
want to use.

Clicking
To click, gently press the left mouse button once and release it. 
The mouse makes a clicking sound. A click selects an item on the 
screen.

Right-Clicking
To right-click, gently press and release the right mouse button. 
Right-click displays a list of commands on the screen. 

Double Clicking
To start any program, point to an item on the screen and quickly 
press and release the left mouse button twice. 

Drag and Drop
The drag operation is done to graphically pick up something on 
the screen and move it. To do that, you point the mouse at the 
thing you want to drag, press and hold the mouse’s button and 
then move the mouse to another location. When you move the 
mouse (and keep the button down), the object moves. To release, 
or drop, the object, release the mouse button.
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Uses of the Mouse

The computer mouse is a pointing device. It is used to point and 
click. It is used to click buttons, boxes and menus.
•	 You may use the mouse to click on a menu name. This action 

opens a list of options called a drop-down menu.
•	 The mouse is used to drag-and-drop an item. Point at the 

item, hold down the left button and move the mouse. The item 
being held will move on screen. Release the mouse button to 
let go of the item.

•	 The mouse may be used to start a program on the desktop. 
Just double click the icon of the program to open it.

•	 The mouse is used to select text. Selected text appears white 
on the screen with a black blackground.

•	 The mouse is used to maximize or minimize a window that is 
open. For these actions, you click on the Maximize button or 
Minimize button on the title bar.

•	 The mouse is used to close an open window.
•	 The mouse is used to scroll. Scrollbars appear when the 

information on the screen is too much and cannot fit.

expanding 
your horizons

Insertion Point and Mouse Pointer

A pointer moves on screen when you move the mouse. 
The pointer on screen is called mouse pointer. The insertion 
point on screen shows the place where the text you type will appear. The insertion 
point is seen only in an area where text can be typed.



26 Computer Zone - Book 3

Keyboard	 :  	An input device is used to enter 
data and instructions into a 
computer.

Arrow keys	 :	 The keys that help us to move the 
cursor in all the four directions 
on the screen.

Spacebar 	 :	 The longest key used to give 
spaces between the letters or 
numbers typed.

Mouse pointer	:	 The slanting arrow, which 
represents the mouse on the 
screen. 

Tricky Terms 

Let 
Us Revise

•	 The device that is used to give the input to a computer is 
called an input device.

•	 Keyboard is used to enter data and instructions into a 
computer.

•	 The keys that have alphabets from A to Z written on them 
are called alphabet keys.

•	 The keys that have numbers from 0 to 9 are called numeric 
keys.

•	 The delete key is used to erase the letter or number on the 
cursor position.

•	 Mouse is another commonly used input device moved by 
hand around a flat surface. 
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Chapter Review
1.	 Fill in the blanks. Choose the answer from the given words.

Clue  Box

Caps lock, Cursor, Enter, Mouse, Keyboard

a.	 _________________is used to enter data and instructions into 
a computer. 	

b.	 ___________________is the blinking line on the screen.
c.	 The________________key tells the computer that the 

instructions being typed are complete.
d.	 The_________________key is used to change from small letters 

to capital letters. 
e.	 The computer’s_______________controls a graphical mouse 

pointer or mouse cursor on the screen.

2.	 Match the followings.
Column A		  Column B
Mouse	   	 An input device used to enter data and 

instructions into a computer.
Spacebar		  The keys that help us to move the cursor in all 

the four directions on the screen.
Mouse pointer 		 The longest key used to give spaces between 

the letters or numbers typed.
Arrow keys		  The slanting arrow, which represents the 

mouse on the screen. 
Keyboard		  A pointing device used to point and click.
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Extrapolative Exercise

Count the number of different types of keys on 
any keyboard in your computer room and write 
them below:
Alphabet keys ____________________________
Number keys  ____________________________
Function keys ____________________________

Answer the following questions.
a.	 What is a computer keyboard? What are the different types of 

keys found on a computer keyboard?
b.	 What are alphabet keys? How many alphabet keys are there 

in a keyboard?
c.	 What is a cursor?
d.	 What is a computer mouse? What are the uses of a computer 

mouse?
e.	 What do you understand by drag and drop?

Rearrange the following jumbled words to make meaningful words.

EDLTEE EKY

CPSAE RBA

HSITF EYK

ACBKPASCE EKY

LPAHBEAT KYE
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•	 Explain the steps to start Windows 7.
•	 	Explain the components of Windows 7 screen.
•	 	List the common activities of the Start menu.
•	 	List the steps to open programs using the Start menu.
•	 	Explain the steps to manipulate Windows.

Chapter4

Learning Objectives

An  Overview

Windows is the name of an 
operating system developed by 
Microsoft Corporation, USA. It is 
a software which helps to operate 
and control the overall activities 
of a computer. It is simple and 
easy to use. It is a Graphical User 
Interface (GUI) in which all items 
are represented in the form of 
graphics. Windows has many 
versions that regularly get updated 
with time and requirements. 

Getting to Know 
Window 7
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Starting Windows 7

Windows 7 is a Graphical User Interface (GUI) in which all the 
items are represented in the form of pictures and graphical links.  
When you switch ON your computer, Windows 7 gets loaded 
automatically. 

a.	 Switch ON the main power supply button.
b.	 Switch ON the power button on the UPS.
c.	 Switch ON the power button on the CPU.
d.	 Switch ON the power button on the monitor.	
e.	 Type the password and press Enter key. Windows 7 desktop 

will appear.

Desktop

expanding 
your horizons

According to Microsoft, Windows 8 is a completely redesigned operating 
system developed from the ground up with touchscreen use in mind as well as 
near-instant-on capabilities that enable a Windows 8 PC to load and start up in 
a matter of seconds rather than in minutes.
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Components of  Windows 7 Screen

The Windows 7 screen displays various components. The 
components depends on how your computer is set up.

Icon

Start button

Taskbar icon
Taskbar

Notification area
Date and Time

Desktop	
Desktop is a work area in Windows. All the basic activities can be 
done from this area.

Icons		
Icons are the small pictures that appear on the Desktop. They 
represent a program or software. To open the icons you have to 
simply double click your mouse on item.

Mouse Pointer
A small arrow on the computer screen, which moves with the 
movement of the mouse, is a mouse pointer. It helps to point, 
click, or double-click the various items on the desktop.

Taskbar	
Taskbar is located at the bottom of the desktop. It contains start 
button at the left corner and clock at the right corner. It also shows 
the programs which are currently opened.

Start Menu
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Taskbar icons	
Taskbar icons are the icons through which you can launch some 
Windows 7 features with just a mouse click.

Time and Date	
On the right corner of the taskbar you can see the current Time 
and Date on your computer. Click on the Time and Date area to 
see the full Time and Date box. You can also change Time and 
Date of computer.

Start button	
The round shaped button on the left of the taskbar is the Start 
button. It is the most usable part of the desktop.

Start menu	
All the installed programs in the computer are listed in a start 
menu.

Notification area	
This area displays small icons that notifies you about the things 
that are currently happened on the computer. 

expanding 
your horizons

Using the new Windows 8 UI, the start screen is the 
main area where you can access apps.  You can think 
of it as home base for Windows 8.  You can personalize 
this start screen by pinning your favorite Windows 8 apps.  The 
start screen is also where you access the charm bar, which allows you to shut 
down and restart your computer as well as set-up and manage your operating 
system.
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An Overview of Start Menu

The Start menu is the main gateway to your computer’s programs, 
folders, and settings. It is called a menu because it provides a list 
of choices. And as “start” implies, it is often the place that you 
will go to start or open things.

Click here  
to start a 
recently used 
program Some folders

Use the Start menu to do these common activities:
•	 Start programs
•	 Open commonly used folders
•	 Search for files, folders, and programs
•	 Adjust computer settings
•	 Get help with the Windows operating system
•	 Turn off the computer
•	 Log off from Windows or switch to a different user account
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Getting started with the Start menu

To open the Start menu, click the Start button in the lower-left 
corner of your screen. Or, press the Windows logo key on your 
keyboard.
The Start menu has three basic parts:
a.	 The large left pane shows a short list of programs on your 

computer. Clicking All Programs displays a complete list of 
programs.

b.	 At the bottom of the left pane is the search box, which allows 
you to look for programs and files on your computer by typing 
in search terms.

c.	 The right pane provides access to commonly used folders, 
files, settings, and features. It is also where you go to log off 
from Windows or turn off your computer.

Facts Corner

The search box is one of the most convenient ways to find things 
on your computer.
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Opening programs from the Start menu

In Windows 7, you have much more control over the programs 
and files that appear on the Start menu. 
To open a program, do the following:
a.	 Click on Start button.
b.	 Click on All Programs to view a list of the programs.
c.	 Click on the program you want to open. Some programs has 

sub-menu.

The Windows Operating System opens a new window for each 
program. It is these windows that have given the operating 
system its name. A window is a box-like frame with documents, 
toolbars, programs and icons.

Quick Access Toolbar

Program button

Tabs

Control buttons

Program Window
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Manipulating Windows

You know that it is possible for us to open more than one window 
on the screen at the same time. The sizes of the windows on 
your screen can be changed so that more windows are visible. 
Following is a list of common features that can be used with all 
windows.
a.	 Maximize 	
	 This option allows you to bring the size of any window to its 

maximum, so that it covers the entire screen.
	 To maximize a window, do the following:
	 i. 	 Click on Maximize button in the window. The window 

fills your screen.
	 ii. 	Click on Restore Down button to return the window to its 

previous size.

b.	 Minimize	
	 This feature of Windows allows you to keep an application 

or program running, but remove it from the desktop area, so 
that other applications can be used. The minimized program 
becomes a bar on the taskbar, and can be used again by clicking 
on it.

	 To minimize a window, do the following:
	 i. 	 Click on Minimize button in the window. The window 

reduces in an icon on the taskbar.
		  To re-display the window, click on the icon of the window 

on the taskbar.

Minimize button Maximize button
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c.	 Resize 	
	 You can easily change the size of a window displayed on your 

screen.
	 To resize a window, do the followings:
	 i. 	 Click the mouse pointer over an edge of the window you 

want to resize.
	 ii.	 Drag the mouse pointer until the window displays the size 

you want.
	 iii.	The window appears in a new size.

After completing your work, you need to switch off your 
computer. To shut down a computer properly, follow the given 
steps:
a.	 Click on Start button. The start menu will appear.
b.	 Click on Shut Down. Window 7 shuts down and turns off the 

computer.
c.	 Switch off the Power Supply.

Shutting Down
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GUI	 :  		A computer interface that uses 
windows, icons and menus and 
which can be manipulated by a 
mouse.

Desktop	 :	 A work area in Windows.
Icons	 :	 The small pictures that appear 

on the Desktop.
Mouse Pointer	:	 A small arrow on the computer 

screen, which moves with the 
movement of the mouse.

Tricky Terms 

Let 
Us Revise

•	 Windows is a software which helps to operate and control 
the overall activities of a computer. It is a user-friendly 
operating system.

•	 Taskbar icons are the icons through which you can launch 
some Windows 7 features with just a mouse click.

•	 Notification area displays small icons that notifies you about 
the things that are currently happened on the computer.

•	 The Start menu is the main gateway to your computer’s 
programs, folders, and settings. 

•	 A window is a box-like frame with documents, toolbars, 
programs and icons.

•	 Maximize option allows you to bring the size of any window 
to its maximum, so that it covers the entire screen. 

•	 You can easily change the size of a window displayed on 
your screen.
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Chapter Review
1.	 Fill in the blanks. Choose the answer from the given words.

Clue  Box

Icons, Start menu, Start button, Notification area, GUI

a.	 Windows 7 is a ________________ in which all the items are 
represented in the form of pictures and graphical links.  

b.	 ____________________are the small pictures that appear on 
the Desktop.

c.	 The round shaped button on the left of the taskbar is the 
_______________________.

d.	 All the installed programs in the computer are listed in a 
______________________.

e.	 _____________________displays small icons that notifies you 
about the things that are currently happened on the computer. 

2.	 Spot the error in these statements. Write each one correctly.

a.	 Windows 7 is a Character User Interface (CUI) in which all 
items are represented in the form of graphics. 

b.	 Cursor helps to point, click, or double-click the various items 
on the desktop.

c.	 The round shaped button on the left of the taskbar is the Start 
menu.

d.	 The left pane provides access to commonly used folders, files, 
settings, and features.

e.	 A desktop is a box-like frame with documents, toolbars, 
programs and icons.
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Answer the following questions.
a.	 What is Microsoft Windows? Name the most recent version 

of Microsoft Windows.
b.	 What is desktop? 
c.	 What are icons?
d.	 Define mouse pointer.
e.	 What does a Taskbar contain?
f.	 What is Start menu? How can you open Start menu?
g.	 What are the common use of Start menu?
h.	 What is a Window? Name the different parts of a program 

window.

Write the steps for following operations.
a.	 Maximizing a Window
b.	 Minimizing a Window
c.	 Resizing a Window

Lesson Labs

After reading this chapter, do all the following activities.
a.	 Start up a computer.
b.	 Find all the elements of Windows 7 Desktop.
c,	 Click on the Start button and make a list of programs in 

your notebook.
d.	 Open a Paint window using the Start button.	  
e.	 Minimize the WordPad window.
c.	 Restore the window from the taskbar.
d.	 Now maximize the window.
d.	 Shut down the computer.
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•	 Explain the steps to start Paint Program.
•	 	Explain the components of Paint window.
•	 	Explain the uses of color boxes of Paint.
•	 	Explain the functions of Paint tools.
•	 	Explain how to work with colors.

Chapter5

Learning Objectives

An  Overview

PAINT is a simple graphic 
program in Windows 7. It is 
presented in Accessories. It allows 
you to draw beautiful pictures 
and colour them. This is done by 
using the various tools and colours 
present in the Paint program. In 
Paint, drawings are made with the 
help of a computer mouse.

Tools in 
Paint
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Starting Paint Program

Let us see how to get into the colourful world of PAINT. Switch 
ON the computer. Your monitor will display Windows Desktop. 
Windows Desktop has a Start button on the bottom left corner. 
a.	 Click on the Start button.
b.	 Click on All Programs.
c.	 Select Accessories. You will notice a list of options.	
d.	 Click on Paint. The Paint window appears on the screen.

The different components of a new Paint window are:
Quick Access Toolbar	 The Quick Access Toolbar is the small 

row of icons, found above the ribbon, 
on the upper left of the screen. It 
contains common commands that you 
use over and over again every day, 
such as Save, Undo, Redo, etc.

Paint Button	 Below the Quick Access toolbar and 
on the left side, there is button called 
Paint button. Clicking on this button 
opens the main menu of Paint.



43Computer Zone - Book 3

Tabs	 There are two tabs: Home Tab and View 
Tab in the Paint.

		  The Home tab contains the Ribbon, from 
which tools and colors are selected.

			  The View tab contains Zoom In/Zoom 
Out, Full Screen mode options.

		  You can also select to show Rulers and 
Gridlines on an image which can help 
you align elements in an image.

Color Boxes

The Color boxes indicate the current Color 1 (foreground color) 
and Color 2 (background color) colors.
The Color 1 box shows the active colors or foreground color. To 
change the foreground color, click on Color 1 box and then click 
on the desired color palette.
The Color 2 box is the background color. The background color 
is the default color of any new image that you create. To change 
the background color, click on Color 2 box and then click on the 
desired color in the Color palette.

Color 1 box

Facts Corner

Use the Color picker tool to set the current foreground or 
background color.

Color 2 box
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Tools in Paint

Paint contains a different tools to draw and insert shapes into 
your drawing. The different types of tools in Paint are: 
Pencil Tool 	 It is used to draw straight, wavy and 

curved lines. It is used as a normal 
pencil. Freehand drawing can be done 
using this tool.

Eraser Tool 	 This tool is just like your normal eraser 
which is used to erase a drawing or a 
part of it.

Brush Tool	 The brush tool is used for drawing 
freehand drawings using coloured 
brush.

Line Tool 	 The line tool is used to draw horizontal, 
vertical or slanting or straight lines of 
different thickness.

Rectangle Tool 	 The rectangle tool is used for drawing 
rectangles or squares. 	

Circle Tool 	 The circle tool is used for drawing oval 
shapes and circles.

Rounded Rectangle Tool	 The rounded rectangle tool is used 
for drawing rectangles with rounded 
corners.

Polygon Tool	 The polygon tool is used for drawing 
polygons.	

Curve Tool	 The curve tool is used to draw curved 
shaped objects.

Text Tool 	 The text tool is used to write text on the 
Paint screen. 
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Drawing Lines

Some tools and shapes, such as the Pencil, Brush, Line, and Curve 
let you make a variety of straight, and curved lines.
To draw lines, do the following:	
a.	 On the Home tab, in the Shapes group, click the tool for the 

type of line you want to draw. 
b.	 In the Colors group, click Color 1, and then click the color you 

want to use.
c.	 To draw, drag the pointer across the drawing area.

Drawing Shapes

Paint lets you draw many different shapes. For example, you 
can draw ready-made, defined shapes such as rectangles, circles, 
squares, triangles, and arrows.
To draw shapes, do the following:	
a.	 On the Home tab, in the Shapes group, click a ready-made 

shape, such as the Rectangle‌.
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b.	 To add a ready-made shape, drag the pointer across the 
drawing area to make the shape.

c.	 To change the outline style, in the Shapes group, click 
Outline, and then click an outline style. 

	 If you don’t want your shape to have an outline, click No 
outline.

d.	 In the Colors group, click Color 1, and then click a color for 
the outline.

e.	 In the Colors group, click Color 2, and then click a color to 
use to fill the shape.

f.	 To change the fill style, in the Shapes group, click Fill, and 
then click a fill style.

	 If you don’t want your shape to be filled, click No fill.

Practical 
	 Skills

a.	 Draw a square. Then draw a circle inside that square.
b.	 Draw a rectangle and a square of  the same thickness and different 

thicknesses.
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Working with color

There are a number of tools to help you work specifically with 
color in Paint. They let you use the colors you want when you’re 
drawing and editing in Paint.

Color picker
The Color picker tool is used to set the current foreground or 
background color. By picking a color from the picture, you can 
make sure that you’re using the color you want when drawing in 
Paint, so your colors match.
To use Color picker tool, do the following:
a.	 On the Home tab, in the Tools group, click Color picker tool.

b.	 Click the color in your picture that you want to set as the 
foreground color, or right-click the color in your picture that 
you want to set as the background color.
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Fill with Color
The Fill with color tool is used to fill the entire picture or an 
enclosed shape with color.
To use Fill with Color tool, do the following:
a.	 On the Home tab, in the Tools group, click Fill with color. 
b.	 In the Colors group, click Color 1, click a color, and then click 

inside the area to fill it.
	 To remove the color and replace it with the background color 

instead, click Color 2, click a color, and then right-click the 
area to fill it.

c.	 To draw, drag the pointer across the drawing area.

Editing colors
The Edit colors is used to pick a new color. Mixing colors in Paint 
lets you choose the exact color that you want to use.
a.	 On the Home tab, in the Colors group, click Edit colors.
b.	 In the Edit Colors dialog box, click a color in the color pallette, 

and then click OK.
	 The color will appear in one of the color boxes, so you can use 

that color in Paint.
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Viewing your picture

Changing the view in Paint lets you choose how you want to 
work with the picture. You can zoom in on a certain part of the 
picture or the whole picture if you want. Conversely, you can 
zoom out if the picture is too large. In addition, you can show 
rulers and gridlines as you work in Paint, which can help you 
work better in Paint.

Magnifier
The Magnifier tool is used to zoom in on a part of your picture.
a.	 On the Home tab, in the Tools group, click the Magnifier tool, 

move the magnifier, and then click to zoom in on the part of 
the image.

b.	 Drag the horizontal and vertical scroll bars on the bottom and 
right side of the window to move around the picture.

	 To reduce the zoom level, right-click the Magnifier again.
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Zoom in and out
Use Zoom in and Zoom out to see a larger or smaller view of 
your image. For example, you might be editing a small part of 
it and need to zoom in to see it. Or the opposite might be true; 
your picture might be too large to fit on the screen, so you need 
to zoom out to view all of it.
In Paint, there are few different ways to zoom in or out, depending 
on what you want to do.
a.	 To increase the zoom level, on the View tab, in the Zoom 

group, click Zoom in.
b.	 To reduce the zoom level, on the View tab, in the Zoom group, 

click Zoom out.
c.	 To view the picture in the Paint window at its actual size, on 

the View tab, in the Zoom group, click 100%.

Tip 
To zoom in and out on a picture, you can also click the Zoom in 
Picture of the Zoom in button or Zoom out Picture of the Zoom 
out button buttons on the Zoom slider at the bottom of the Paint 
window to increase or decrease the zoom level.
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Saving and using your picture

When editing in Paint, you should save your work frequently so 
you don’t accidentally lose it. After you save your picture, you 
can use it on your computer or share it with others in e‑mail.

Save a picture for the first time
When you save a new picture for the first time, you’ll need to 
give it a file name.
a.	 Click the Paint button, and then click Save.
b.	 In the Save as type box, select the file format you want.
c.	 In the File name box, type a name, and then click Save. 

Open a picture
Instead of starting with a new picture, you might want to open 
an existing picture and edit in Paint.
a.	 Click the Paint button and then click Open.
b.	 Find the picture you want to open in Paint, click it, and then 

click Open. 

Set your picture as your desktop background
You can also set the picture, so it’s used as the desktop background 
on your computer.
a.	 Click the Paint button, point to Set as desktop background, 

and then click one of the desktop background settings.
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Paint	 :  		A simple graphic program in 
Windows 7 that allows to draw 
beautiful pictures and colour 
them.

Accessories	 :	 Additional programs that help 
us doing various jobs such as 
painting, creating documents, etc.

Color 1 box	 : 		 Box that shows the active colors 
or foreground color. 

Zoom	 :		 Term used to describe a function 
of focusing on a section of the 
image and increasing its overall 
size.

Tricky Terms 

Let 
Us Revise

•	 Windows is a software which helps to operate and control 
the overall activities of a computer. It is a user-friendly 
operating system.

•	 Pencil tool  is used to draw straight, wavy and curved lines. 
•	 Brush tool is used for drawing freehand drawings using 

coloured brush.
•	 Rounded rectangle tool is used for drawing rectangles with 

rounded corners.
•	 Curve tool is used to draw curved shaped objects.
•	 Color picker tool is used to set the current foreground or 

background color. 
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Chapter Review
1.	 Fill in the blanks. Choose the answer from the given words.

Clue  Box

Color 1, Color picker,  View,  Text,  Line

a.		 The___________________tab contains Zoom In/Zoom Out, 
Full Screen mode options. 

b.	 The________________box shows the active colors or 
foreground color.

c.	 The_______________tool is used to draw horizontal, vertical 
or slanting or straight lines of different thickness.

d.	 The_______________tool is used to write text on the Paint 
screen. 

e.	 The_______________tool is used to set the current foreground 
or background color. 

2.	 Match the followings.
Rectangle Tool	 used to draw straight, wavy and curved 

lines.
Brush Tool	 used to erase a drawing or a part of it.
Line Tool	 used for drawing freehand drawings 

using coloured brush.
Eraser Tool 	 used to draw horizontal, vertical or 

slanting or straight lines of different 
thickness.

Pencil Tool 	 used for drawing rectangles or 
squares. 	
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3.	 Answer the following questions.
a.	 What is a Paint program?
b.	 What are the different components of a new Paint window?
c.	 What does Color box indicate?
d.	 	What does the following tools help you to do?
	 i. Line Tool
	 ii. Brush Tool
	 iii. Airbrush Tool
e.	 What is the use of Color picker tool?
f.	 Why do we use Zoom tool?

Lesson Labs

Draw a picture in Paint and set it as the background of the 
Desktop.
a.  		 Open the Paint Program.
b.	 Make a drawing in the drawing area. Colour and save it 

using the File | Save As option.

c.	 Decrease the size of the drawing area by dragging inwards 
from the bottom right corner.

d.	 Click on the File Menu. Select either of these two options.
	 Set As Background (Tiled)
	 Set As Background (Centered)
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a.	 Draw 3 kites using the Polygon tool. Colour them differently.
b.	 Pick the colour of the first kite and in the same colour, write 

‘First’ beneath the kite. Choose a suitable font and size for 
it. Similarly, write ‘Second’ and ‘Third’ below the other two 
kites.

c.	 Save the file with the name ‘Kites’ in My Documents. Now, 
choose only the third kite and copy it to a new file. Give a 
suitable name to this file.

Draw the following pictures and colour them with the help of 
the PAINT program.
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•	 Define word processor.
•	 	Explain the different components of WordPad window.
•	 	List the steps to enter text in WordPad.
•	 	Explain the difference between moving and copying text.
•	 	Define formatting text and list the different options available in 
formatting text.

Chapter6

Learning Objectives

An  Overview

Word processor is a software that 
helps you to type your text on a 
computer. The process of typing in, 
using a word processor is known 
as word processing. WordPad is a 
word processing program present 
in Windows Accessories. It allows 
you to create simple letters and 
documents. It also provides many 
formatting features to give an 
attractive look to your documents.

WordPad
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Starting WordPad Program

Switch ON the computer. Your monitor displays Windows 
Desktop. Windows Desktop has a Start button on the bottom left 
corner. 
To start the WordPad program, do the following:
a.	 Click on the Start button.
b.	 Click on All Programs.
c.	 Select Accessories. You will notice a list of options.	
d.	 Click on WordPad. 
The WordPad window appears on the screen. 

The different components of a WordPad window are:
The Title Bar	 The title bar contains a Quick Access 

toolbar that has “Save,” “Undo” and 
“Redo” buttons. It is also possible to 
add “New,” “Open,” “Send in email,” 
“Quick print” and “Print preview” 
buttons through customization of the 
Quick Access toolbar.
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Menu Button	 The WordPad menu button contains 
buttons to create a new document, 
open a document, save a document, 
save a document as another name or 
format, print a document, and send 
document in an email. 

Home Tab	 The “Home” tab in WordPad contains 
clipboard, font, paragraph, insert and 
editing sections. It has many font 
options. The paragraph section contains 
alignment and indentation buttons 
and a button for bullets for lists. The 
insert section contains an area to insert 
a picture, object or drawing. It also 
has a button for adding the date and 
time. The editing section has “Find,” 
“Replace” and “Select all” buttons.

View Tab	 In the “View” tab, you can adjust the 
zoom, show or hide the ruler and 
status bar, and adjust the settings of the 
word wrap and measurement units. 
The options for measurement units are 
inches, centimeters, points and picas.

Practical 
	 Skills

Switch on the computer.
Open WordPad and identify the different parts of WordPad window.
Type few line about your school and save the file.
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Entering Text in WordPad

It is very simple to work in the WordPad program. The blinking 
cursor indicates that the WordPad is ready to accept text. The 
letters typed by you appears at the cursor’s position in the work 
area. The text automatically wraps itself as the insertion point 
reaches the end of the right margin. This property of the text-
wrapping itself to the next line when it goes past the right margin 
is called the word wrap.
To enter text in WordPad, do the following:	
a.	 Type a paragraph.
b.	 Press Enter key only when you want to start a new line or 

paragraph.
c.	 Type the remaining text. 
d.	 Press Enter key again to start another paragraph.

Work Area

Cursor Position
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Highlighting the Text

Highlighting text in WordPad works the same way in other text 
editing software, such as Microsoft Word. However, there are 
some special tricks to use when highlighting text in WordPad, 
such as the ability to highlight single words, phrases, whole 
sentences or paragraphs.
Mouse Highlighting
a.		 Highlight any text by positioning the mouse cursor at the 

starting point of the text to highlight. Click the left mouse 
button and keep the mouse pressed down. Move the mouse 
cursor to the end of the text you want highlighted.

b.		 Highlight specific words by double clicking on any word 
of interest to highlight the word. A single click removes the 
highlight. 

c.	 Combine mouse and keyboard by holding down the shift key, 
and moving the mouse to your selected endpoint and then 
click on the left mouse button at that point.
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Moving and Copying Text

It is easy to move or copy text. When you move text, it disappears 
from its earlier location and gets placed at the new location. When 
you copy text, it can be seen both in its original location and the 
new one.
Moving Text
a.		 Select the text to be moved.
b.	 Click on the Home tab.
c.	 Click on the Cut button.
d.	 Bring the cursor to the position where you want to paste it.  

Click on the Paste button.  The selected text will move to the 
cursor position.

You may also use the drag-and-drop action to move text.
a.	 Select the text to be moved.
b.	 Place the mouse pointer anywhere in the selected text.
c.	 Hold down the left mouse button and drag to move the 

selected text to its new location.

Hickory Dickory Dock
The mouse ran up the clock
The clock struck one,
The mouse ran down
Hickory Dickory dock

Selected text

The mouse ran down
Hickory Dickory dock
Hickory Dickory Dock
The mouse ran up the clock
The clock struck one,

text dragged to its news 
location.

You can use CTRL + X to cut the selected text and CTRL + V to 
paste the selected text.
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Copying Text
a.		 Select the text to be copied.
b.	 Click on the Home tab.
c.	 Click on the Copy button.
d.	 Bring the cursor to the position where you want to paste it.  

Click on the Paste button. The selected text will get copied to 
the cursor position.

Formatting Text

Formatting is the process of changing the appearance of the 
document to make it more presentable. The different options 
available in formatting text are:
a.	 Changing the font style and font size
b.	 Making text bold, italic or underlined
c.	 Alignment of the text
d.	 Changing the colour of the text

Changing the font, font style, or font size of a text
a.	 Select the text whose formatting you want to change.
b.	 Click on Home tab in the Font group.
c.	 Click on the down arrow of Font. Then choose the font you want 

to use.
d.	 Click on the down arrow of Font Size. Then choose the size you 

want to use.
e.	 Click on one of the following buttons: B, I or U. The text you have 

selected appears in the new style.

Click one of the 
following button to 
change the font style.
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Changing the alignment of the Text
Alignment refers to the way text is set with respect to the margins.  
You can set alignment of a paragraph or the whole document. 
There are four options for text alignments. They are left alignment, 
right alignment, center alignment and justify alignment. 
a.	 Select the text you want to align differently.
b.	 Click on Home tab in the Paragraph group. 
c.	 Move the mouse pointer over one of the alignment options.
d.	 The text displays the new alignment.

Click here to 
select alignment 
options.

Changing the colour of text
By default, the colour of the text is black. However, you can 
change the colour of the text.
a.	 Select the text whose colour you want to change.
b.	 Click on Home tab in the Font group.
c.	 Click on the Text color button.
d.	 Select the appropriate colour.

Click here to 
select text colour.
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Adding Pictures in a document

The new WordPad in Windows 7 makes inserting pictures quite 
easy. You can insert a picture into a WordPad document in a few 
short steps.
a.	 On the Home tab, in the Insert group, click Picture.

b.	 Locate the picture that you want to insert, and then click Open.

Click here to 
insert picture.

Inserting Date and Time

You can insert date and time in your document. The text you 
insert appears in all printouts of your story.
a.	 On the Home tab, in the Insert group, click Date and time.
b.	 Click the format you want, and then click OK.

Choose the format.

Click on Ok button.
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Save and Open documents

You should save your document to store it for future use. This 
lets you later open the document for making changes to it.
a.	 Save a document	
	 Click the WordPad menu button, and then click Save.

b.	 Save a document with a new name or format
	 Click the WordPad menu button, point to Save as, and then 

click the format you want to save the document in.

c.	 Open a document		
	 Click the WordPad menu button, and then click Open.

Practical 
	 Skills

1. 	 Type the following text given below exactly. 
	 Willie Worm and his family lived in an apple tree.
	 Every one was contented, except Willie. He hated apples! 
2.	 Change the title font to Arial (or a font of your choice), 16 pt.
3.	 Center the title.
4. 	 Add italics and bold to the word “Willie Worm”.

Saves changes 
to an already 
saved file

Opens an existing 
file

Saves a new file
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Word processor	 :  		A software that helps you to 
type your text on a computer. 

Word wrap	 :	 The automatic placement of 
word in the next line.

Formatting 	 :	 The process of changing the 
appearance of the document 
to make it more presentable.

Font	 :	 A set of characters with a 
specific design. 

Alignment	 :	 It refers to the way text is set 
with respect to the margins. 

Tricky Terms 

Let 
Us Revise

•	 Word processor is a software that helps you to type your text 
on a computer.

•	 The “Home” tab in WordPad contains clipboard, font, 
paragraph, insert and editing sections.

•	 When you move text, it disappears from its earlier location 
and gets placed at the new location.

•	 When you copy text, it can be seen both in its original location 
and the new one.

•	 Formatting is the process of changing the appearance of the 
document to make it more presentable.

•	 Alignment refers to the way text is set with respect to the 
margins. 
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Chapter Review
1.	 Fill in the blanks. Choose the answer from the given words.

Clue  Box

Formatting, Title bar, WordPad, Alignment, Cursor

a.		 ____________________allows you to create simple letters and 
documents.

b.	 The _________________contains a Quick Access toolbar that 
has “Save,” “Undo” and “Redo” buttons.

c.	 The blinking______________indicates that the WordPad is 
ready to accept text. 

d.	 _________________is the process of changing the appearance 
of the document to make it more presentable.

e.	 __________________refers to the way text is set with respect 
to the margins. 

2.	 Match the followings.
Word processor		 A software that helps you to type 

your text on a computer. 
Word wrap		 The automatic placement of word in 

the next line.
Formatting 		 The process of changing the 

appearance of the document to make 
it more presentable.

Font		 A set of characters with a specific 
design. 

Alignment		 It refers to the way text is set with 
respect to the margins. 
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3.	 Answer the following questions.
a.	 What is a word processor?
b.	 What is Wordpad? What are the different components of 

WordPad?
c.	 What is a word wrap?
d.	 What do you understand by formatting?
e.	 What are the different options available in formatting text?
f.	 What is alignment of text?
g.	 Write the steps to perform the following operations:
	 i. Change the font of a text
	 ii.	Saving a document
	

Lesson Labs

Open a new file in the WordPad Program and type the given text and 
make the text appear as shown below.

King Arthur

Once upon a time long ago, even before the days of King Arthur, there lived 
a blacksmith only three feet tall. He was so short that he needed a stool to 
stand on to shoe the great steeds of the knights. This bothered him not a 
bit because although he was small he was very brave. In fact, in his heart he 
secretly longed to become a knight and win the hand of the Princess.

a.	 	Bold and center the title “King Arthur”.

b.	 Change the title font to a font of your choice to 18 points.

c.	 Add a colour of your choice to the title text.

d.	 Change the font of entire document to Times New Roman.  

e.	 Save the document as King Arthur.

f.	 Close the document and exit WordPad. 
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Open a new file in the WordPad Program and type the given text and 
make the text appear as shown below.

Michael “Mickey” Mouse

Michael “Mickey” Mouse is a comic animal cartoon character who has become 
a symbol for The Walt Disney Company. He was created in 1928 and voiced 
by Walt Disney. The Walt Disney Company celebrates his birth as November 
18, 1928 upon the release of Steamboat Willie. The mouse has evolved from 
being simply a character in animated cartoons and comic strips to become 
one of the most recognizable symbols in the world.	 .

a.	 	Change the title font to Arial Black (or a font of your choice), 16 
pt.

b.	 Add a colour of your choice to the title text.

c.	 Bold and center the title.

d.	 Format the entire document to Courier New.

e.	 Insert any suitable clipart below the title text.

f. 	 Change the alignment to justified.

g.	 Save the document as “Mickey Mouse”.

h.	 Close the document.

i.	 Exit WordPad.
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•	 Explain the importance of MSWLOGO.
•	 	List the steps to start and exit MSWLOGO.
•	 	Explain the different parts of MSWLOGO screen.
•	 	Define LOGO turtle.
•	 	Explain the use of different MSWLOGO primitives.

Chapter7

Learning Objectives

An  Overview

LOGO is a graphic-oriented 
programming language.It 
was designed by SEYMOUR 
PAPERT and his co-workers at 
the Massachusetts Institute of 
Technology in USA in the late 
1960s.  It was designed for the 
children to communicate with the 
computer more easily, especially to 
learn mathematics.  It  also allows 
the children to create, design and 
generate computer code.  

Fun with
MSWLOGO
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Starting and Exiting MSW LOGO

LOGO stands for Language Of Graphic Oriented. You can start 
the LOGO program by following these steps:
a.	 Place the mouse pointer over the Start button on the Taskbar 

and click with the left mouse button. 
b.	 On the Start menu, move the mouse pointer up until All 

Programs is highlighted. A Programs submenu will appear 
to the right.

c.	 Move the pointer to Microsoft Windows Logo in the Programs 
menu. A submenu appears.

d.	 Click on Microsoft Windows Logo.

Title bar
Menu bar

Main Screen

Commander Window

Recall List Box

Command Input Box

You can exit LOGO in two ways:
a.	 Click on File menu in the Menu bar at the top of LOGO screen. 

File menu will appear. Then click on Exit. 
	 Or
b.	 Type ‘Bye’ in the command input box and press the Enter key 

from the keyboard.
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Parts of MSWLOGO Screen

The two main parts of MSWLOGO screen are: Graphic screen 
and Commander Window. 

Graphic Screen
The Graphic screen is the area where the turtle moves and draws 
figures. The Turtle is placed at the centre of this screen.  It moves 
on the screen according to the commands given by you. These 
commands are also known as primitives.

Commander Window
The commander window is the area where commands are 
entered to draw the shapes and figures. The commander window 
is further divided into three sections. They are:

Command Input Box
Command input box is a small area located at the bottom of the 
screen. All the LOGO primitives are typed in this area. To execute 
the commands, you need to do one of the following:
•	 Click in the Input Box and type a command.
•	 Click on the Execute button or press Enter key on the keyboard.
For example: 
Try typing FD 100 and then press the Enter key.

Recall List Box
Recall list box is grey in colour and is used to view the commands 
executed before. All the executed commands get printed in this 
area. It is placed just above the command input box.	
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Control Buttons
Control buttons are the buttons which are placed on the right 
side of the commander window in the LOGO screen.	
Halt Button	 -	 It immediately stops the working of LOGO 

command.
Reset Button	 -	 It is used to erase everything drawn on the 

screen and to bring the turtle back to the 
center of the screen.

Execute Button	 -	 It is used to run the command after typing 
it in the Input box.

EDALL Button	 -	 Edall button is located to the right of the 
Execute button. Clicking at this brings up 
an Editor button that allows you to see 
all the procedures at once. Procedures are 
named group of commands.

Status button	 -	 This button is used to display a status 
window showing the current settings.

Pause button	 -	 This button is used to stop the execution 
of current LOGO program temporarily so 
that you can make changes in the program.

Facts Corner

The  halt button stops the execution permanently, whereas the 
pause button stops it for a short while.
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Enter MSWLogo Commands

a.	 Click in the Input Box at the bottom of the MSW Logo 
commander window.

b.	 Type in the command.
	 FD 100
	 RT 90
	 FD 100
	 RT 90
	 FD 100
	 RT 90
	 FD 100
	 RT 90
c.	 Press the Enter key, or click the Execute button at the right of 

the Commander Window.

LOGO Turtle

LOGO Turtle is a small triangular 
shaped figure. It is placed at the centre 
of the LOGO screen. It has a pen that 
follows the commands and draw shapes. 
It can move in all directions according 
to the instructions given to it. Turtle 
understands only LOGO commands. 
It has two body parts:
•	 The pointed top at the turtle is called head.
•	 The flat bottom of the turtle is called its tail.

Head of Turtle

Tail of Turtle
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Moving the Turtle

The turtle appears in the middle of the Graphic window with its 
head upwards. You can move the turtle up, down, left or right 
on the screen by giving it suitable commands. Turtle moves and 
draws a line as per the commands given by you in the command 
input box.

FORWARD (FD) command
The FORWARD (FD) command is used to move the turtle in 
the forward direction by the specified number of steps. The 
FORWARD command is written as,
FORWARD <number of steps>	
                 or
FD <number of steps> 

To move the turtle forward, do the following:	  
•	 Type FORWARD or FD.
•	 Press the Space bar key.
•	 Type in the number of steps.
•	 Press the Enter key.

FORWARD 100
The turtle moves forward by 100 
steps.
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BACK (BK) command
The BACK (BK) command is used to move the turtle in the 
backward direction without turning its head. The BACK 
command is written as,
BACK <number of steps>
                 or
BK <number of steps> 

To move the turtle backward, do the following:	
•	 Type BACK or BK.
•	 Press the Space bar key.
•	 Type in the number of steps.
•	 Press the Enter key.

BACK 100
The turtle moves backward by 100 
steps.

Practical 
	 Skills

Turtle has to board the bus to go the school. The bus is nine steps away from 
him. He will move back in opposite direction of his face to reach there.

The command we should give is .........................................................................
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Turning the Turtle

The turtle can turn in different directions. It can turn to its right 
or left depending upon the commands you give.	

RIGHT (RT) command
The RIGHT (RT) command makes the turtle turn towards  right 
direction i.e. in the clockwise direction. While turning, the turtle 
rotates, but stays at the same distance from the center.  The RIGHT 
command is written as,
RIGHT <number of degrees>
            or
RT <number of degrees>
The number of degrees can be from 0 to 360. 
To turn the turtle towards the right, do the following:	
•	 Type RIGHT or RT.
•	 Press the Space bar key.
•	 Type in the number of steps the turtle should turn.	
•	 Press the Enter key.

FD 100 RT 90
The turtle moves forward by 100 
steps and turns the turtle 90o.
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LEFT (LT) command
The LEFT (LT) command makes the turtle turn towards left 
direction i.e. in the anti-clockwise direction. While turning, the 
turtle rotates, but stays at the same distance from the center.  The 
LEFT command is written as,
LEFT <number of degrees>
            or
LT <number of degrees>
The number of degrees can be from 0 to 360. 
To turn the turtle towards the right, do the following:	
•	 Type LEFT or LT.
•	 Press the Space bar key.
•	 Type in the number of steps the turtle should turn.	
•	 Press the Enter key.

FD 100 LT 90
The turtle moves forward by 100 
steps and turns the turtle 90o.

Practical 
	 Skills

Turtle is talking and facing his friend Minku. Now he wants to turn to his friend 
Pinku. Give the appropriate command as shown.

Minku Minku

Pinku Pinku
_________ _________
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Home of the Turtle

The turtle appears at the centre of the screen with the head 
pointing upwards. The centre of the screen is called the Home of 
the turtle. The HOME command brings the turtle to its starting 
position. It makes the turtle draw the figure as it moves to the 
center of the screen. It is written as, 
HOME

FD 100	 RT 120	
FD 100	 HOME
The turtle moves forward by 100 
steps, turns the turtle 45o and 
again moves the turtle forward by 
100 steps. The HOME command 
will bring the turtle at the center of 
the screen.

ClearScreen command

The CLEARSCREEN (CS) command clears all the drawings from 
the graphic screen. The Turtle moves to its HOME, which is the 
centre of the screen. The CLEAR SCREEN command is written 
as,
 CLEARSCREEN or CS

ClearText command

The CLEARTEXT (CT) command is used to clear the text 
appearing in the Command Recall Box. It is written as ClearText 
or CT.
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LOGO	 -	 A simple computer language, 
which can be used to draw 
pictures and do calculations.

Primitives	 -	 The basic LOGO commands 
given to the turtle.

Turtle	 -	 A triangle shaped figure at the 
centre of the LOGO window. 

Home	 -	 The centre of the screen, where 
the turtle is positioned when you 
start MSWLogo.

Tricky Terms 

Let 
Us Revise

•	 LOGO is a graphic-oriented programming language.  
•	 LOGO was designed by SEYMOUR PAPERT and his co-

workers at the Massachusetts Institute of Technology in 
USA in the late 1960s. 

•	 The Graphic screen is the area where the turtle moves and 
draws figures. 

•	 The Graphic screen is the area where the turtle moves and 
draws figures. 

•	 LOGO Turtle is a small triangular shaped figure.
•	 The FORWARD (FD) command is used to move the turtle 

in the forward direction by the specified number of steps.
•	 The RIGHT (RT) command makes the turtle turn towards  

right direction i.e. in the clockwise direction. 
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Chapter Review
1.	 Fill in the blanks.
a.	 LOGO stands for_________________________________. 
b.	 The____________________is the area where the turtle 

moves and draws figures. 
c.	 ____________________has a pen that follows the commands 

and draw shapes. 
d.	 The___________________command is used to move the 

turtle in the backward direction without turning its head.
e.	 The___________________command makes the turtle turn 

towards  right direction i.e. in the clockwise direction. 

2.	 Say whether these sentences are True or False.
a.	 The MSWLOGO is a computer program that is used to 

draw figures and type text.
b.	 The Pause button stops the execution permanently.
c.	 MSWLOGO commands are called primitives.
d.	 The HOME command brings the turtle to its starting 

position.
e.	 The CLEARSCREEN (CS) command is used to clear the text 

appearing in the Command Recall Box.

3.	 Write the use of the MSWLOGO primitives.
a.	 FD
b.	 RT
c.	 HOME
d.	 CT
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4.	 Match the followings.
CLEARSCREEN	 Clear the text screen
BACK		 Bring the turtle to the centre of the 

screen
HOME		 Move the head of the turtle to right 

direction
RT			 Move the turtle to the backward 

position
CLEARTEXT	 Clear the screen

5.	 Answer the following questions.
a.	 What is LOGO? Name the two parts in which the LOGO 

screen is divided.
b.	 What is the use of Graphic screen?
c.	 Draw and define Turtle. Where is it located?
d.	 Why do we use RT and LT commands?
e.	 What is the function of HOME command?

Lesson Labs

Convert these sentences into commands, type them and draw the 
figure that you get on the screen. 

a.	 Move forward by 50 steps	 ___________

	 Turn right by 90o			  ___________

	 Move forward by 50 steps	 ___________

	 Move back by 60 steps	 ___________
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b.	 Turn right by 30o			  ___________

	 Move forward by 80 steps	 ___________

	 Move back by 40 steps	 ___________

	 Turn left by 60o			   ___________

	 Move forward by 40 steps	 ___________

c.	 Turn right by 30o			  ___________

	 Move forward by 90 steps	 ___________

	 Move back by 90 steps	 ___________

	 Turn left by 60o			   ___________	

Show the pattern drawn by the turtle in each case. Check by typing 
the commands on the computer.

a.	 CS 				    b.	 CS

	 FD 40					     FD 60

	 RT 90					     RT 90

	 FD 20					     FD 30

	 RT 90					     BK 30

	 FD 40					     RT 90

	 RT 90					     FD 20

	 FD 20					     LT 20	 			 
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Complete the following primitives.

a.	 FD 60

	 _____

	 FD 60

	 RT 90

	 _____

	 _____

	 _____

b.	 _____

	 RT 90

	 _____

	 BK 60

c.	 FD 80

	 BK 40

	 _____

	 FD 10

	 BK 40

	 _____

	 _____	


